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1. Overview 
 
 

Welcome to CIRCOR Select, a sizing and selection software tool that calculates 
sizing properties based on process service conditions in order to select and fully 
specify products for Leslie Controls and Mallard Control of Circor International.    In 
addition to basic product sizing and selection, the program also provides selection for 
the actuator, accessories, materials, and factory notes.  This document details the 
numerous features and aspects of the program. 
 

CIRCOR Select is designed and developed as an intuitive, user friendly program to 
provide a technically sound product selection and produce the following industry 
standard reports. 
 

 Specification Sheet 
 Analysis Sheet 
 Orifice Sheet 
 Flow Curve 
 Outline Drawing 
 Factory Notes/QA Plan 

 

CIRCOR Select intelligently restricts or expands the attribute values of products 
based upon the process service conditions.  It also determines if any adverse 
conditions exists, warning the user and recommending possible solutions.  
 

Since CIRCOR Select incorporates both Leslie Controls and Mallard Control 

products, user can configure equipment for both brands into a single project. 
 

CIRCOR Select provides a feature for the user to create a profile to define 
preferences such as Product Brand, Unit of Measurement system (English or Metric), 
and particular units within those systems.  The profile values are used as default 
values within the program; however, the program allows the user to change these 
values while using the program without having to update the profile.  Additionally, 
multiple profiles can be stored within the product to facilitate multiple users and/or 
quickly change default values for specific application sizing. 
 

CIRCOR Select facilitates sharing of project data between users via import and 
export functions.  This function enables one or more line items to be exported from a 
project and imported into another, allowing multiple users to work on a project. 



CIRCOR Select User Manual v2.0.0 Page 6 

2. System Requirements 
 
 

CIRCOR Select requires the following hardware and software to properly execute. 
 
 
Minimum Hardware Requirements: 
 

 Intel® Pentium® IV or equivalent 
 1 GB of RAM 
 150 MB of available disk space on the hard drive (system drive) 

 
 
Recommended Hardware Requirements: 
 

 Intel® Pentium® Dual Core 2.2 GHz or equivalent 
 3 GB of RAM 
 500 MB of available disk space on the hard drive (system drive) 

 
 
Compatible Operating Systems: 
 

 Microsoft® Windows XP® Professional – SP2 or above 
 Microsoft® Windows 7  Professional (32 bit) 

 
 
Supporting Software: 
 

 Adobe® Reader® or equivalent PDF reader 
 Microsoft® Report Viewer (a component of Windows) 

 
 
Recommended Minimum Screen Resolution: 
 

 1024 x 768 pixels 
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3. Application Installation 
 
 

To install CIRCOR Select:  
 
 

 Caution: Administrative privileges are required to install this application.  
Please contact your Administrator to obtain the necessary permission if 
required. 

 
 

 Click (or Double-Click) on the CIRCOR Select Setup 
file to initiate the installation process. 

 
 

The setup will guide you through the installation; once installed, the CIRCOR Select 
icon will be placed on the desk top. 
 
 

For detailed information on the installation process, see the CIRCOR Select 
Installation & Quick Start Guide. 
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4. Application Startup 
 
 

Click (or double-click) the CIRCOR Select icon on the Desktop to start the 
application.  Alternatively, clicking Start ���� All Programs ����  CIRCOR Select ���� 
CIRCOR Select will also start the application. 
 

 Note: An internet connection is required to check for the latest updates when 
starting the program and to register the program (on initial startup only). 

 
 

Initial Startup (Registration) 

 
The software must be registered in order to receive an activation key, which is 
required to use the program.  With an open internet connection, furnish the 
information required for registration and click [Submit]; an email will be sent 
immediately containing the activation key.  Enter the activation key when prompted 
and click [OK] to proceed. 
 
After registering and activating the software, you will be prompted to choose User 
Defaults. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Next to proceed to the User Defaults screen. 
 

Or 
 

 Click Exit to close the application. 
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User Defaults (Preferences) 

 
The User Defaults screen sets the preferences selected by the user.  It is subdivided 
into different sections covered below. 
 

 Note: Product Brand, User Name, Company Name, User Phone and User 
Email must be entered in order to save preferences.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 General Configuration Defaults 
 

 User Interface Language - Language in which the user can interact with the 
application; once the language is selected the labels of objects on the user 
interface, error messages and the user prompts will be displayed in the 
selected language.  The list of values will also be displayed in the selected 
language.  The default user interface language is ‘English’. 
Note: Only English language is currently supported. 

 Background – Background color for the screens within the application. 
 Confirm on Deletion of Item (check box) – If this box is checked, then the 
user will be prompted to confirm before line item is deleted.  If this box is 
unchecked, then the line item will be deleted without user confirmation. 

 Product Brand – User can select which product brand (Leslie / Mallard) to 
typically use.  Product and attribute selections throughout the program are 
relevant to the selected brand. 

 Recently Used Projects – This is number of recently used projects that are 
displayed on the opening project screen when the application is started. 
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 User Information 
 

 User Name – Name of the person using the application. 
 Company Name – Name of the company of the user. 
 User Phone – Contact number of the user. 
 User Email – Email ID of the user. 
 User Location – Select user country, or country and region, from list.  If 
location is not listed, select ‘Other’ and enter manually. 
 

 Default Service Conditions 
 

 First Heading – Name of the first column heading of service conditions.  
Default is ‘Max’. 

 Second Heading – Name of the second column heading of service 
conditions.  Default is ‘Norm’. 

 Third Heading – Name of the third column heading of service conditions.  
Default is ‘Min’. 

 Fourth Heading – Name of the fourth column heading of service conditions.  
Default is ‘Cond4’. 

 Fifth Heading – Name of the fifth column heading of service conditions.  
Default is ‘Cond5’. 
 

 Calculation Variable Defaults 
 

 Allow. SPL (dBA) – Allowable Sound Pressure Level in A-weighted decibels.  
Values between 70 and 120 are allowed; the default value is 85. 
 

 Print Options 
 

 Actual Velocity No. (check box) – If this box is checked, then the actual 
velocity rates will be displayed in the printed reports.  If this box is 
unchecked, the actual velocity rates will not be displayed in the printed 
reports; ‘Normal’ or ‘High’ will be reported instead. 

 Actual Cavitation Index No. (check box) - If this box is checked, then the 
actual cavitation index will be displayed in the printed reports.  If this box 
is unchecked, the actual cavitation index will not be displayed in the 
printed reports; ‘Normal’ or ‘High’ will be reported instead. 

 Advisories - If this box is checked, then the program advisories will be 
printed in the output reports.  If this box is unchecked, the program 
advisories will not be printed in the output reports.  
 

 Default U/M Selection 
 

 Unit System – User can select between the English or Metric unit of 
measurement (UOM) systems.  Individual selection of values for the 
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following attributes as well as those used within the program will be 
generated based on the unit system selected. 

 Steam Flow Rate – UOM for rate of steam flow. 
 Water Flow Rate – UOM for rate of water flow. 
 Gas Flow Rate – UOM for rate of gas flow. 
 Liquid Flow Rate – UOM for rate of liquid flow. 
 2-Phase Flow Rate – UOM for rate of total two-phase flow. 
 2-Phase Partial Flow Rate – UOM for rate of partial two-phase flow. 
 Pressure – UOM for pressure. 
 Temperature – UOM for temperature. 
 Viscosity – UOM for viscosity. 
 

 Preferences 
 

 Profile – Name of the profile to save the default preferences selected.  
Profile name ‘Default’ cannot be deleted.  Multiple profiles can be created; 
additional profiles can be saved and deleted. 
 

 Note: If a new profile is linked to an existing project then the default values 
specified in the profile would be applicable only to the items added after 
linking the profile.  The existing line items would not be affected. 
 

Once preferences are set, click Save (or Save As) to proceed.  Once the preferences 
are set after initial startup, subsequent startup of the application will begin with the 
opening project view screen. 



CIRCOR Select User Manual v2.0.0 Page 12 

Opening Project View 

 
The Opening Project View screen is a dialog box that allows the user to create a new 
project or open an existing project.  Refer to Chapter 6 Project for more information. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Create New Project file to start a new project. 
 

 Click Open to retrieve a saved project file or simply click on one of the recently 
used projects displayed.  The number of projects displayed depends on the value 
set in the Preferences. 
 

 Click Exit to close the application. 
 

 Note: CIRCOR Select is designed to be “sizing-centered”, which means the 
user will always be taken directly to the Sizing/Selection screen regardless 
whether a new project is created or an existing project is opened. 
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5. Interface & Navigation 
 
 

CIRCOR Select is designed with a split screen interface for easy and quick 
navigation.  Being “sizing-centered”, the program will always initially display the 
Sizing/Selection screen (shown below) upon startup.  The left side of the screen is the 
project/line item navigation section and the right side is the application work area.  
Navigation from this screen to other areas of the program is detailed below. 

 
 

 The Project/Item Navigation section facilitates switching between the project and 
the line items.  In the navigation section, all the line items that are included in 
the open project are displayed as individual child nodes under the Project node. 
 

 Note: The navigation section can be resized by mousing over the divider (click 
when mouse changes, hold, move and release), or it can be hidden by clicking 
on the Project tack.  To restore the navigation section, click on the vertical 
Project button and click on the Project tack to pin it. 
 

Menu Items 

Menu Item Options 

Project/Item 

Navigation Status Indicator 

Advisories 
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 Clicking Project navigates the user to Project Info contained within the 
Project menu item. 
 

 Clicking on any Line Item displays the sizing and selection data for the 
selected item. 
 

 Clicking on any Menu Item navigates the user to that particular menu.  Each of the 
menu items is covered in its own chapter.  Each menu items displays its associated 
Menu Item Options horizontally on the bar under menu item bar. 
 

 Click Advisories, if present (enabled), to open a dialog box and view the current 
advisories related to the sizing and selection of the product.  The advisories dialog 
box may also contain recommendations for the advisory. 
 

 The Status Indicator displays the state of the current products selection.  See the 
Status Indicator section in Chapter 8 Sizing/Selection for more information. 

 
 

 Tool Tips:  On most drop down lists and in other areas where indicated, placing 
the mouse over the selection/result provides a brief explanation or additional 
information known as tool tip.  These can be very helpful, and they are used 
throughout the program. 

 

Menu Items 

Menu Item Options 

Project/Item 

Navigation Status Indicator 

Advisories 
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6. Project 
 
 

In CIRCOR Select, Projects contain one or more line items.  Only one project can 
be open at a time.  The Opening Project View, which is displayed on program startup, 
allows the user to create a new project or open an existing project.  The Project 
menu contains the following menu options: Save, New, Open, Save As, Project Info, 
Reports and Exit, which are explained in detail below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save Project 

 

To save a project in CIRCOR Select: 
 

 Click Save from the Project menu options. 
 

 Note: Navigating from the Project Info screen automatically prompts the user 
to save if changes have been made. 
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New Project 

 

 To create a new CIRCOR Select project file: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on Create New Project file from the Opening Project View or New from the 
Project menu options to access the Save dialog box. 
 

 Enter the project file name.  The default location to save the file is the My 
Document folder.  Save to any other folder by clicking the Save in drop down box. 
 

 Click Save once the file name and folder location is entered. 
 
A new valve line item is automatically created, and the user is taken to the 
Sizing/Selection screen. 
 

 Note: Upon clicking New from the Project menu options, if changes have been 
made to the current project, then the user will be asked to save the changes.  
On confirmation, the changes will be saved, and the current project file will be 
closed before displaying the Save dialog box.  Otherwise, the current project 
file will be closed without saving the changes before displaying the Save dialog 
box. 
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Open Project 

 

To open an existing CIRCOR Select project file: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on the project file from the list of recently used projects displayed on the 
Opening Project View.  The number of projects displayed depends on the value set 
in the Preferences. 
 

 Click on Open from the Opening Project View or from the Project menu options to 
access the Open dialog box, which displays all the previously created projects in 
the My Documents folder and then select from the list.  If project files are saved in 
any other folder, then first click Look in to select the folder and then select the 
project file from that folder.  Once selected, the user is taken to the 
Sizing/Selection screen.  
 

 Note: Upon clicking Open from the Project menu, if changes have been made 
to the current project, then the user will be asked to save the changes.  On 
confirmation, the changes will be saved, and the current project file will be 
closed before displaying the Open dialog box.  Otherwise, the current project 
file will be closed without saving the changes before displaying the Open dialog 
box. 
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Save As 

 

To copy an existing CIRCOR Select project file including all line items into another 
project file: 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Open an existing project file. 
 

 Click Save As from the Project menu options to access the Save As dialog box. 
 

 Enter the project file name.  The default location to save the file is the My 
Document folder.  Save to any other folder by clicking the Save in drop down box. 
 

 Click Save once the file name and folder location is entered. 
 

 Note: Upon clicking Save As, if changes have been made to the current 
project, then the user will be asked to save the changes.  On confirmation, the 
changes will be saved, and the current project file will be closed before 
displaying the Save As dialog box.  Otherwise, the current project file will be 
closed without saving the changes before displaying the Save As dialog box. 
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Project Info 

 

The CIRCOR Select Project Info screen allows the user to enter or edit general 
information about the project. 
 

 
 
 

 Click Project Info from the Project menu options to access the project information 
screen or click on Project in the project/line item navigation pane. 
 

 Entering information in this screen is non-mandatory to save the file, however it is 
highly recommended that all fields are completed as much of this information is 
used on the output reports. 
 

 The bottom of the screen displays all the items that are added to the project 
along with its Configuration and Pricing Status. Details of the individual item can 
be viewed / edited by selecting the item in the project navigation section. 
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 Note: Line items with invalid Configuration Status are not included in the 
Project Cost. Similarly line items with valid Configuration Status but invalid 
Pricing Status are not included in Project Cost. 
  

 Note: Pricing Status for valid line item is set to invalid and price for the line 
item is set to zero, if changes are made to the line item configuration.  

 
 

 Project Information - Project 
 

 Project Name – Any name can be assigned to a project.  This should help in 
identifying the project when the project is opened.  Ideally, but not 
necessarily, the name entered should be the same or have some similarity 
as the name given to the project file. 

 Plant Name – Name of the plant where the items will be installed. 
 Plant Site – Select location of the plant where the items will be installed 
from list.  If location is not listed, select ‘Other’ and enter manually. 

 Industry – Select industry associated with the plant operation from list.  If 
industry is not listed, select ‘Other’ and enter manually. 

 Plant Capacity – Capacity of the plant, if applicable. ‘(MW)’ is displayed if 
Industry is Power Generation. 

 End User – Name of the owner of the plant. 
 Engr. Contractor – Name of the Engineering Contractor of the plant 
installing the items. 

 Total Items – Displays the number of items in the project.  This field is 
automatically filled and cannot be changed by the user. 

 Req. Delivery – Enter the requested lead time in number of weeks after 
receipt of order (ARO). 

 Notes – Comments or special instructions associated with the overall 
project. 

 
 Project Information – Quotation 
 

 Quote No. – Quote number associated with the project. 
 Quote Rev. – Revision number of the quote. 
 Quote Date – Date of the quote; default is the current date. 
 Customer – Name of the customer procuring items. 
 Contact Name – Customer contact name. 
 Contact Phone – Customer contact phone. 
 Contact Email – Customer contact email. 
 Customer RFQ No. – Customer request for quote (RFQ) number. 
 Customer RFQ Rev. – Customer RFQ revision number. 
 Project Cost – Total for all primary valid line items. 
 

 Note: Price for alternate solutions is excluded. 
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 Project Information – User Information 
 

 User Name – Name of the person using the application. 
 Company Name – Name of the company of the user. 
 User Phone – Contact number of the user. 
 User Email – Email ID of the user. 
 User Location – Select user country, or country and region, from list.  If 
location is not listed, select ‘Other’ and enter manually. 
 

 Note: User information is automatically entered from the User Defaults, which 
can be edited from the Settings -> Preferences menu. 
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Project Commercial Details 

 

The CIRCOR Select Project Commercial Details displays all line items within a 

project with its Configuration and Pricing Status. In addition it also displays alternate 
solutions, if any, for any primary line item selected. 
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Reports 

 
CIRCOR Select provides the following professional output reports: 
 

 Specification Sheet 
 Analysis Sheet 
 Orifice Sheet 
 Flow Curve 
 Outline Drawing 
 Factory Notes/QA Plan 

 

Exit 

 

To exit and close the CIRCOR Select project and application, click on Exit under 

the Project menu. 
 

 Note: This will close the open project and the application without saving. 
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7. Items 
 
 

In CIRCOR Select, Items are products that can be added to projects.  Currently, 
control valves are available to be added as line items.  The Items menu contains the 
following menu options: Add, Save, Copy, Delete, Lock/Un-Lock Item and Alternate 
Solution, which are explained in detail below. 
 
 

 
 
 

Add Item 

 

To add a line item to a project in CIRCOR Select: 
 

 Click on the down arrow “▼” next to Add from the Item menu options, and then 
click on Control Valve, 
 
or 
 

 Press CTRL + N on the keyboard, 
 
or 
 

 Right click on Project in the project/line item navigation pane, and then click Add 
New Control Valve. 
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Save Item 

 

To save a line item to a project in CIRCOR Select: 
 

 Click Save under the Items menu options or Sizing/Selection menu options, 
 
or 
 

 Press CTRL + S on the keyboard,  
 
or 
 

 Right click on the line item in the project/line item navigation pane, and then 
click Save. 

 
 
 
 
 
 
 
 
 
 
 
 

Copy Item 

 

To copy a line item within a project in CIRCOR Select, highlight the line item to be 
copied, then: 
 

 Click Copy under the Items menu options, and then enter the new line item 
description, 
 
or 
 

 Press CTRL + C on the keyboard, and then enter the new line item description, 
 
or 
 

 Right click on the line item in the project/line item navigation pane, click Copy, 
and then enter the new line item description. 
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Alternate Solutions Functionality 

 

The Alternate solution functionality in CIRCOR Select, helps users to compare 
different valve solutions for given service conditions. 
 
Users can compare the solutions based on various important parameters like Valve 
Model, Size, Body Material, Flow Characteristics, Rated Cv, Travel, Sound, Velocity, 
Actuator and Price.  
 
Alternate solutions are listed under the primary item as child line items. 
  

 
 

 Users can create alternative configuration solutions that could meet his service 
requirements.  
 

 The comparative analysis helps users to choose the most appropriate product in 
terms of performance and price.   

 
 Note: The Primary line item is the active solution. In Project cost only the 
pricing of Primary Line Item is included, the pricing of Alternate solutions are 
not included.  The pricing of Alternate solution is included in project cost only 
if it is set as Primary. The option to set an Alternate solution as Primary Item is 
explained further ahead. 
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Copy As Alternate 

 
The Copy As Alternate option creates a copy of the selected Primary/Alternate line 
item as Alternate Solution. You can create multiple Alternate solutions using this 
option. All the alternate solutions will be listed as child items under the Primary Line 
Item. 
 

To use the Copy As Alternate option in Items Menu of a project in CIRCOR Select,   
highlight the line item to be copied, then: 
 

 Click on the down arrow “▼” next to Copy from the Item menu options, and then 
click on Copy As Alternate, 
 

 

 
 

 The Select Line Item screen will be displayed. If the selected Line Item is a 
Primary line item, the same will be highlighted by default. If the selected Line 
Item is an Alternate solution i.e. child item, then the Parent line will be 
highlighted by default. Select the Primary line item under which the selected line 
item on the navigation pane is to be copied under as Alternate line item. 
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 Click Ok.  

 
 Enter the name of the new line item. A Copy of the selected Primary/Alternate 
Line Item will be copied as a child Item under the highlighted Primary Line Item 
selected in Select Primary Line screen.   
 

 
 

 Click OK. 
 

 Note: If a selected line item is copied under a different Primary line item, the 
status indicator changes to Calculation and Saving Required. 

 - as displayed in Project/Line Navigation Pane 

  - as displayed on Line Item Status indicator on 
the top 
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Or 
 

 Right click on the line item in the project/line item navigation pane, click Copy As 
Alternate, Click OK, Enter the name of new Line Item and then click Ok. 
 
 

 
 

 Note: Service data of the primary line item will be applied automatically to all 
the child items. User will not be allowed to change the service conditions on 
the child items. Changing service conditions on primary line items would result 
in invalidating all the alternate solutions of child items requiring the user to 
revalidate the same. 
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Copy With Alternate  

 
The Copy With Alternate option copies the entire set consisting of Primary Line and 
Alternate solutions.  
 

 Note: The Copy With Alternate is enabled only when you select a primary line 
item. The new line item is an exact copy of the selected primary line item and 
includes the primary item and child items. 
 

To   use the Copy With Alternate option in Items Menu of a project in CIRCOR 
Select, highlight the Primary Line Item to be copied, then: 

 
 
 

 
 

 Click on the down arrow “▼” next to Copy from the Item menu options, and then 
click on Copy With Alternate, 
 
 

 
 
 

 Enter the name of the new Line Item. 
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 Click OK. A new Line item is created containing the selected primary line item 
along with all its child items. The line item description for child items is 
automatically created using the line item description entered for the Primary line 
item followed by a hyphen and a sequential number starting from 1. 
 
Or 
 

 Right click on the line item in the project/line item navigation pane, click Copy 
with Alternate, Enter the name of new Line Item and then click Ok. 
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Copy As Primary 

 
 
The Copy As Primary option is used to create a Primary line item from an existing 
Alternate solution i.e. child Item.  
  

To use the Copy As Primary option in Items Menu of a project in CIRCOR Select, 
highlight the child item to be copied, then: 
 

 
 Click on the down arrow “▼” next to Copy from the Item menu options, and then 
click on Copy As Primary, 

 
 

 
 
 

 Enter the name of the new Line Item. 
 

 
 

 Click Ok. A new Primary Line item is created from the selected child item. 
 
 
Or 
 

 Right click on the child item in the project/line item navigation pane, click Copy 
As Primary, Enter the name of new Line Item and then click Ok. 
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Set as Primary 

 
The set as Primary option is used to set an Alternate solution as the Primary Line 
item. The selected Alternate item will be switched with Primary Line item and the 
earlier Primary Line item becomes a child item.    
 
 

 
 

To set an Alternate item as Primary item within a project in CIRCOR Select, 
 

 Click the Alternate item to set as Primary item 
 
 

 Right click on the Alternate item in the project/line item navigation pane, click 
Set As Primary. 
 

 Note: The selected Alternate item will be listed as a Primary item and the 
previous Primary item will now be Alternate solution or child item. 
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Delete Item 

 

To delete a line item within a project in CIRCOR Select, highlight the line item to 
be deleted, then: 
 

 Click Delete under the Items menu options, and then confirm deletion (if enabled 
– see User Defaults in Chapter 4 Application Startup), 
 
or 
 

 Press CTRL + D on the keyboard, and then confirm deletion (if enabled – see User 
Defaults in Chapter 4 Application Startup), 
 
or 
 

 Right click on the line item in the project/line item navigation pane, click Delete, 
and then confirm deletion (if enabled – see User Defaults in Chapter 4 Application 
Startup). 
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Delete Alternate Solutions 

 

To delete all Alternate Solution of a Primary item within a project in CIRCOR 
Select, highlight the Primary item  

 

 
 

 Click on the down arrow “▼” next to Delete from the Item menu options, and 
then click on Delete Alternate Solutions, 

 
 

 
 

 Click Yes to delete all the child line items. 
 

 
or 
 

 Right click on selected Line item in the project/line item navigation pane, and 
then click Delete Alternate Solutions 
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Lock Item 

 
Item can be locked to prevent unintentional modification of the same. On locking a 
Primary line item, all Alternate solutions are also locked.  
 
A locked item is exported as locked item, similarly its status remains locked when 
imported into different project. 
 
Locked items are not modified or updated when the project file is opened in a higher 
application version.  
 
Line items submitted to customer should ideally be locked to prevent them from 
being changed during the project file update process to make it compatible with new 
application version or to avoid accidental changes to the configuration 
 

To lock a primary line item within a project in CIRCOR Select, highlight the primary 
line item to be locked, then: 
 

 Click on the Primary Line Item , and then click on Lock Item under the Items 
Menu, 

 

 
 
or 
 

 Right click on Primary Line Item in the project/line item navigation pane, and 
then click Lock. 
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Un-Lock Item 

 
A locked Primary item can be unlocked using this option.  The lock option above 
works as toggle. When a locked item is selected the ‘Lock’ option changes to ‘Un-
Lock’ and clicking on it unlocks the item.  
 
On unlocking, the application will apply any updates if the project file is being 
opened in a new application version than the one used for configuring the line item at 
the time when it was locked. On unlocking, all the alternate solutions will also be 
unlocked. 
 
Item can be modified once unlocked. 
 

To Un-lock a primary line item within a project in CIRCOR Select, highlight the 
primary line item to be unlocked, then: 
 

 Click on the Primary Line Item , and then click on Un-Lock Item under the Items 
Menu, 

 

 
 

or 
 
 

 Right click on Primary Line Item in the project/line item navigation pane, and 
then click Un-Lock. 
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Alternate Solution 

 

The Alternate Solution under items menu within a project in CIRCOR Select has two 
options 
 

 Add Alternate Solution 
 Compare Solution 

 

 
 

  

Add Alternate Solution 

 
The Add Alternate Solution creates a copy of service conditions of the Primary Line 
Item as an Alternate Item. User is required to make a new selection and validate the 
same.   
 
To add an Alternate Solution to a line item of a project in CIRCOR Select: 
 

 
 

 Select the Primary Line Item 
 

 Click on the down arrow “▼” next to Alternate Solution  from the Item menu 
options, and then click on Add Alternate Solution, 
 

 
 

or 
 

 Press CTRL + N on the keyboard, 
 
or 
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 Right click on Primary Line Item in the project/line item navigation pane, and 
then click Add Alternate Solution. 
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Compare Solutions 

 
Compare Solutions allows to compare the Primary solution with Alternate solution/s 
on various parameters like Valve Model, Size, Body Material, Trim Type, Flow 
Characteristics, Required Cv, Rated Cv, Travel %, Noise, Fl, Velocity, Flow Condition, 
Actuator Type and Price. In addition it allows to compare the Inherent Flow Curves for 
Primary and Alternate Solutions. 
 
Solutions can be compared only if Primary and one Alternate solution are not invalid. 
 
To compare solutions, highlight the Primary line item or Alternate solution to be 
compared, then: 
 

 
 

 Click on the down arrow “▼” next to Alternate Solution from the Item menu 
options, and then click on Compare Solutions, 
 

The following compare solutions screen is displayed  
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Compare Alternate Solutions 

 
 Select View Type – There are 2 different views for comparing Primary solution 
with Alternate solutions. 
 

 Single Service Condition – ‘Single Service Condition’ view is the default 
selected view and compares results for 1 service condition at a time. Select 
the condition title to select the service condition to compare. 
 

 All Service Conditions – Select ‘All Service Conditions’ view to compare 
results for all service Conditions. 
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View Graph Comparison 

 
View Graph comparison allows users to quickly compare the flow curve depicting the 
Cv% v/s Travel% for Primary and Alternate Solutions. 
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8. Sizing/Selection 
 
 

In CIRCOR Select, Sizing/Selection is the core of the program, enabling the user to 
calculate sizing parameters in order to fully configure and specify products.  The 
Sizing/Selection menu contains the following menu options: Save, Item Information, 
Sizing/Selection, Actuator, Accessories, Materials, Factory Notes/QA Plan, and 
Reports, which are explained in detail below.  The function of the Status Indicator is 
also addressed in this chapter. 
 
 
 
 
 
 
 
 

Save Item 

 

To save the current line item in CIRCOR Select: 
 

 Click Save under the Items menu options or Sizing/Selection menu options, 
 
or 
 

 Press CTRL + S on the keyboard,  
 
or 
 

 Right click on the line item in the project/line item navigation pane, and then 
click Save. 

 
 

Status Indicator 
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Item Information 

 

The CIRCOR Select Item Information screen allows the user to enter or change 
general information about the selected line item. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Item Information from the Sizing/Selection menu options to access the item 
information screen. 
 

 Entering information in this screen is non-mandatory to save the file, however it is 
highly recommended that all fields are completed as much of this information is 
used on the output reports. 
 

 Item Information – General 
 

 Item Desc. – Brief description of the line item; the default is Line Item#, 
where # is the next line item number.  When changed by the user, the line 
item description in the Project Navigation pane is updated once the line 
item is saved.  (Corresponding field on Sizing/Selection screen.) 

 Quantity – Required quantity of the line item. 
 Unit Number – Plant unit number where the product will be installed. 
 Line/PID No. – Plant line or PID number where the product will be installed. 
 Notes – Comments or special instructions associated with the line item 
product specification. 
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 Item Information – Tag Information 
 

 Click in the Desc. field to enter the first tag number.  The number of tag 
descriptions that can be entered is limited to the quantity entered in the 
general section of the item information.  The first tag number is always 
given and cannot be deleted. 

 To add more tag numbers, right click in the box to bring up the Add / 
Delete menu.  Click Add, and then enter the next tag number.  Repeat for 
each tag number required.  
 
 
 
 
 
 
 
 
 
 
 

 To edit a tag number description, click (or double-click) on the description 
to make edits. 

 To delete a tag number, first click on the tag number to be deleted, then 
right click in the box to bring up the Add / Delete menu.  Click Delete, and 
then confirm deletion (if enabled – see User Defaults in Chapter 4 
Application Startup).  The first tag number cannot be deleted. 
 

 Item Information – Revision Information 
 

 Revision – Item revision number; defaults to zero first time line item is 
saved. 

 Revision Date – Click check box to enable.  Click down arrow to bring up 
calendar and select revision date.  Defaults to current date. 

 Revision Comments – Details of revision changes. 
 

 Item Information – Equipment Location 
 

 Equipment Location – Select indoor or outdoor; default is outdoor. 
 Min. Ambient Temp. – Minimum ambient temperature exposure of the 
equipment. 

 Max. Ambient Temp. – Maximum ambient temperature exposure of the 
equipment. 

 Area Classification – Default is ‘Non-Hazardous’.  If the equipment is being 
installed in a hazardous location, select ‘Enter Haz Loc Classification’ and 
input the hazardous location area classification. 
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Sizing/Selection 

 

CIRCOR Select is designed to be “sizing-centered” by displaying the 
Sizing/Selection screen whenever a project is started or opened or when adding a new 
line item.  This is the initial screen to begin the product configuration process. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Product sizing and selection is basically a three step process: 
 

 Enter application requirements and service conditions for sizing then click 
Calculate to obtain uncorrected, or estimated, Cv. 
 

 Select a model and appropriate product attributes. 
 

 Click Re-Calc to obtain actual required Cv and confirm compatibility of 
product selection with application requirements and service conditions. 

 
Details of this process and all screen parameters follow. 
 
The Sizing/Selection screen contains the two tabs, Sizing and Selection.  There are 
four distinct sections under the sizing tab as indicated in the screen shot above. 
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The screen is designed to flow from top to bottom, left to right within each section.  
Beginning at the top left: 
 

 Sizing Section 1 – General Item Information 
 

 Product Brand – Defines which product models will be available within the 
Selection tab.  Defaults to the selected user preference (see Chapter 10 
Settings), but it can be changed for the line item being sized.  Changing the 
product brand here does not affect the user preferences.  Mousing over the 
product brands displays a tool tip containing more information on the 
brands listed. 

 Application – List of common product applications.  For an application not 
listed, select ‘Other’ at bottom of list and manually enter application.  
Mousing over the applications listed displays a tool tip containing more 
information and suggestions for product selection. 

 Item Desc. - Brief description of the line item; the default is Line Item#, 
where # is the next line item number.  When changed by the user, the line 
item description in the Project Navigation pane is updated once the line 
item is saved.  (Corresponding field on Item Information screen.) 

 Tag No. – Tag number of the line item.  Only the first tag number can be 
entered (or displayed) in this field.  For multiple tag numbers associated 
with the line item, all other tag numbers must be entered in the Item 
Information screen. 

 CE Required (check box) – Check this box if CE compliance of the line item 
is required for use in the European Union (EU).  Checking this box enables 
“PED Category” to be selected. 

 PED Category – Enable this control by checking the “CE Required” check 
box.  Lists available PED categories.  If unsure or unaware of the PED 
category required, select ‘Unknown’ and the factory will advise. 

 
 Note: To quickly size an application, no data is required to be entered in this 
section as the Product Brand is automatically selected from the User Defaults. 
 

 Note: “CE Required” and “PED Category” only apply to Leslie Controls products 
and are not displayed for Mallard Control products. 

 
 Sizing Section 2 – Application Requirements 
 

 UOM – Unit of measure (UOM) system to be used, English or Metric.  
Defaults to the selected user preference (see Chapter 10 Settings), but it 
can be changed for the line item being sized.  Changing the UOM here does 
not affect the user preferences. 

 Fluid Type – Type of fluid.  Available fluid types are: Steam, Water, Gas, 
Liquid, and Two-Phase. 
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 Fluid Name – Name of the fluid.  A fluid library is available for Gas, Liquid, 
and Two-Phase fluid types.  If a fluid name is not present, select ‘Other’ 
and manually enter. 

 Pipe Line Data, Insulation – Type of pipe line insulation.  Pipe insulation 
affects noise calculations. 

 Pipe Line Data, Thck. – Thickness of the selected pipe line insulation.  This 
becomes enabled when pipe line insulation is selected. 

 Pipe Line Data, Size In – Inlet pipe line size.  In English UOM, the pipe size 
is given in Nominal Pipe Size (NPS); in Metric UOM, the pipe size is given in 
Diameter Nominal (DN).  If pipe size is not listed, select ‘Other’ and enter 
the actual outside diameter of the pipe in the “O.D.” text box. 

 Pipe Line Data, Sch. In – Inlet pipe line schedule.  Pipe schedule depends 
on pipe size.  If pipe schedule is not listed, select ‘Other’ and enter the 
actual wall thickness of the pipe in the “Wall Thck.” text box. 

 Pipe Line Data, Size Out – Outlet pipe line size.  Defaults to the inlet pipe 
line size.  In English UOM, the pipe size is given in Nominal Pipe Size (NPS); 
in Metric UOM, the pipe size is given in Diameter Nominal (DN).  If pipe size 
is not listed, select ‘Other’ and enter the actual outside diameter of the 
pipe in the “O.D.” text box (limits are .405” [10.3 mm] to 60” [1524 mm]). 

 Pipe Line Data, Sch. Out – Outlet pipe line schedule.  Defaults to the inlet 
pipe line schedule.  Pipe schedule depends on pipe size.  If pipe schedule is 
not listed, select ‘Other’ and enter the actual wall thickness of the pipe in 
the “Wall Thck.” text box (limit is less than ½ pipe OD). 

 Valve Conditions, Shut-Off Press. – Pressure required for shut-off.  It 
automatically populates with the highest pressure of all service conditions 
when the Calculate button is clicked, however a higher pressure may be 
entered.  Shut-off pressure directly affects actuator sizing. 

 Valve Conditions, Shut-Off Temp. – Temperature at shut-off.  It 
automatically populates with the highest temperature of all service 
conditions when the Calculate button is clicked, however a higher 
temperature may be entered. 

 Valve Conditions, Design Press. – Design or maximum system pressure is 
used to determine the ANSI class rating.  Design pressure auto fills from 
Shut-Off pressure so it automatically populates with the highest pressure of 
all service conditions when the Calculate button is clicked, however a 
higher pressure may be entered. 

 Valve Conditions, Design Temp. – Design or maximum system temperature 
is also used to determine the ANSI class rating.  Design temperature auto 
fills from Shut-Off temperature so it automatically populates with the 
highest temperature of all service conditions when the Calculate button is 
clicked, however a higher temperature may be entered. 

 Valve Conditions, Allow SPL – Allowable sound pressure level (SPL).  
Defaults to the selected user preference (see Chapter 10 Settings), but it 
can be changed for the line item being sized.  Changing the allowable SPL 
here does not affect the user preferences. 
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 Valve Conditions, Service – The type of service, or usage, of the product.  
On-off or modulating for control valves are the basic service types, however 
modulating is sub-divided into three categories: Continuously Modulating, 
Intermittent Modulating, and 2% Intermittent, which indicates the product 
is closed most of the time, controlling only about 2% of its life span.  
Service type, along with materials selected, affects velocity limitations. 

 
 Sizing Section 3 – Service Conditions 
 

 No Service Conditions (check box) – Check this box in order to bypass 
entering service conditions.  This function is typically used when replacing a 
product in the field with limited or no service conditions available.  Since 
shut-off and design pressure and temperature can still be entered, this 
function maintains attribute filtering and allows sizing of the actuator for 
the product selected, however flow condition warnings cannot be displayed. 
 

 Caution: The user assumes all responsibility for the product meeting the 
application requirements. 
 

 Calc – Type of calculation to be performed based on service condition 
entered.  Defaults to Cv; calculations for Flow, P1 (inlet pressure), or P2 
(outlet pressure) are also available.  When calculating for Flow, P1, or P2, 
that particular parameter is changed to display “Rated Cv”.  Enter the rated 
Cv of the selected valve in the appropriate box then click Calculate.  The 
rated Cv is displayed in the results section below and the calculated 
parameter (Flow, P1, or P2) is displayed in its appropriate box. 

 Headings – Names for the service condition columns.  Defaults to the 
selected user preference (see Chapter 10 Settings), but it can be changed 
for the line item being sized.  Changing any heading here does not affect 
the user preferences.  Clicking on the arrow between headings copies the 
service conditions from the heading on the left to the heading on its right.  
Right clicking on a column heading displays a sub-menu to Copy, Clear, or 
Paste the contents the column providing the ability to copy the first column 
data into the third, fourth, or fifth column, for example, or clearing the 
contents of a single column. 
 
 
 
 
 
 
 

 Parameters – Service condition parameters required for calculations appear 
on the left side of this section.  Boxes with a white background require user 
input.  Depending on the fluid type, different parameters are required to be 
entered.  For listed fluid names, some parameters with white backgrounds 
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are filled with approximated values indicated with an asterisk.  These 
values can be changed if actual data is known.  Values in boxes with a gray 
background cannot be changed. 

 Units – Specific units of measurements based upon the UOM system chosen 
appear on the right side of this section.  Defaults to the selected user 
preference (see Chapter 10 Settings), but it can be changed for the line 
item being sized.  Changing any unit here does not affect the user 
preferences.  If service conditions are present, changing the unit type 
converts the given value.  Changing the UOM in section 2 of this screen 
converts the values between the English and Metric systems.  This 
facilitates the entering of service conditions with mixed units between the 
UOM systems and among the units available within a given UOM system. 
 

 Caution: Some values require more than one parameter to convert such as a 
volumetric flow rate to a weight flow rate, or vice-versa, which requires 
density, or specific volume, for the conversion.  If the all the required 
parameters are unknown, then the entered values will not convert and remain 
as entered. 
 

 Sizing Section 4 – Results 
 

 Calculate/Re-Calc – Upon clicking, performs the necessary calculations to 
provide Cv, travel, predicted SPL, velocity, and posts any flow condition 
warnings.  If insufficient data is provided, a dialog box is displayed 
requesting the required data.  Changing service conditions or product 
selections requires a recalculation to be preformed.  The button changes to 
“Re-Calc” and turns red to alert the user. 

 Uncorrected/Required Cv – Displays calculated Cv.  After initially entering 
service conditions and prior to product selection, clicking Calculate gives an 
Uncorrected, or estimated, Cv based on assumptions of valve parameters.  
Once product selection is complete, clicking Re-Calc provides the actual 
Required Cv based on the valve parameters of the selected product. 

 Rated Cv – Displays the rated Cv of the product selected.  Prior to selecting 
product, this box remains blank (when calculating Uncorrected Cv).  If rated 
Cv is less than required Cv, then the box turns red to alert user. 

 Travel (%) – Displays the percent of travel position of the valve.  Prior to 
selecting product, this box remains blank (when calculating Uncorrected 
Cv). 

 Pred. SPL, IEC (dBA) – Displays predicted sound pressure level (SPL) per the 
IEC standard in A-weighted decibel units.  If predicted SPL is greater than 
allowable SPL, the box turns red to alert the user. 

 FL/XT – Displays appropriate valve parameter based on fluid type.  For 
water, liquid, or two-phase, FL is given.  For steam or gas, XT is given. 

 Velocity – Displays the state of the velocity as either “Normal” or “High”.  
Mousing over the result displays a tool tip containing the actual inlet, body, 
and outlet velocity along with the velocity limitation.  If the inlet, body, or 
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outlet velocity is greater than the velocity limit, then the box turns red to 
alert the user. 

 Flow Condition – Displays the state of the flowing conditions as either 
“Normal” or “X Warnings”, where X equals the number of warnings present.  
Mousing over the result displays warnings if present and other data in some 
cases such as the cavitation index for water or liquids.  Double clicking the 
flow condition result when warnings are present opens a dialog box listing 
the warnings and offer recommendations to resolve them.  If warnings are 
present, the box turns red to alert the user. 

 Clear Service Conditions – Clicking this button clears all the service 
conditions entered including the shut-off and design pressure and 
temperature. 

 
 Selection 
 

 Order Code – The ordering code, or part number, generated based off the 
product selections made.  Manual edits to this field are not permitted. 

 Model – Valve model lines available based on the Product Brand selected 
and the service conditions entered (once an initial calculation has been 
made).  Mousing over the models listed displays a tool tip containing 
additional information on the specifics of the model line. 

 Attributes – Product attributes appear once a model is selected.  Attributes 
listed depend on the model line.  See the Leslie’s or Mallard’s product 
literature on the given model for details of the attributes.  Attribute 
options are filtered based on fluid types, service conditions, and previously 
selected attributes.  Some attribute options allow the user to select ‘Other’ 
and manually enter a desired value.  The final attribute for all model lines 
is Rated Cv, which should be greater than or equal to the Uncorrected or 
Required Cv displayed in the results (section 4) of the sizing tab. 

 
 Re-Calc and Confirm 
 

 Re-Calc – Once all application requirements and sizing parameters have 
been entered and all product selections have been made, click Re-Calc as 
this is the final step to the basic sizing and selection process. 

 Confirm – Review any and all advisories and flow condition warnings, and 
check the status indicator (see Status Indicator section in this chapter) to 
ensure the product selection is compatible with the application sizing. 

 Reiterate – Make adjustments to the application requirements, sizing 
parameters, and/or product selections based on the recommendations of 
the advisories and flow condition warnings, if any, to specify the most 
appropriate valve for the application and service intended. 
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Orifice Plates  

 
In order to use the orifice plate (OP) option, end user (EU) needs to  
 

 have fluid selection on Steam or Gas,  
 have entered at least one set of service conditions,  
 have selected a valve and  
 have run the recalculation routine with the selected vave, 

 
at which point the OP tab will become active. Once Tab is active click on it to enter 
the GUI (graphic users interface). 
 

 
 
Once in the OP Tab, please press the CALCULATE button to let the computer calculate 
the plate and outlet connection size. Once firmed and satisfied with results, press 
Accept to  
 

 accept OP design and 
 go back to valve sizing tab 

 
If you are not satisfied with results, EU needs to return to the sizing tab and adjust 
service conditions and repeat steps from the top. 
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Actuator 

 

The CIRCOR Select Actuator screen sizes and selects an actuator for the selected 
line item.  It also allows the user to specify an alternate actuator, providing the data 
required for its proper selection. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Actuator from the Sizing/Selection menu options to access the actuator 
screen. 
 

 Actuator – Attributes 
 

 Actuator Type – Type of actuation.  Upon selecting a Leslie or Mallard 
actuator, the program automatically sizes the actuator, selecting the 
smallest actuator to achieve the shut-off required.  Default is ‘None’.  
Specify an unlisted actuator type by selecting ‘Other’ and manually enter 
when prompted. 

 Actuator Action – Action of the actuator spring.  Reverse acting indicates 
the spring extends the actuator stem.  Direct acting indicates the spring 
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retracts the actuator stem.  This attribute is used for Mallard products only.  
Defaults to ‘Reverse Acting’. 

 Fail Position – Position of the valve upon complete loss of air pressure or 
motive medium (e.g. electrical supply or hydraulic pressure) to the 
actuator.  Also, indentifies the valve position and motion of the actuator 
based on the input signal (i.e. tending to open on increasing signal or 
tending to close on increasing signal), which is needed for double-acting  
type actuators.  Defaults to ‘Closed’. 

 Lock in Last Position – Locks the valve at its existing position upon loss of 
air pressure or motive medium to the actuator using a Lock-up Relay Valve.  
Defaults to ‘No’.  Selecting ‘Yes’ requires the use of a lock-up valve; a 
message is posted alerting the user to specify it in the Accessories screen.  
This attribute is used for Leslie product only. 

 Service – The type of service, or usage, of the product; displays  ‘On-off’ or 
‘Modulating’ based on the selection from the Sizing/Selection screen. 

 Leakage Class – Amount of allowable leakage thru the seat ring per 
ANSI/FCI 70-2 unless otherwise noted within the program. 

 Avail. Max Air Supply – Maximum air supply pressure available to the 
actuator. 

 Avail. Min Air Supply – Minimum air supply pressure available to the 
actuator. 

 Actuator Size – Size of the actuator.  Defaults to the minimum required 
actuator size to achieve full valve shut-off. 

 Span (Spring No.) – Differential pressure required to achieve full valve 
travel.  The spring number associated with the listed Span values is 
provided in parentheses.  This attribute is used for Leslie product only. 

 Spring Setting (Range) – Pressure setting for choosing an actuator spring.  
The range associated with the listed spring settings is provided in 
parentheses.  The differential pressure of the range is equal to the Span. 
This attribute is used for Mallard products only. 

 HOD – Hand Override Device, typically a handwheel.  Allows for manual 
override operation of the valve. 

 Orientation – Orientation of the actuator with respect to the valve. 
 Actuator Model No. – The Model No. of the Leslie or Mallard actuator 
specified. 
 

 Actuator – Valve Details 
 

 Order Code – The ordering code, or part number, generated based off the 
product selections made.  Manual edits to this field are not permitted. 

 Valve Model – Valve model line displayed based on product selection from 
the Sizing/Selection screen. 

 Valve Size – Valve size displayed based on product selection from the 
Sizing/Selection screen. 

 Trim Size – Valve trim size displayed based on product selection from the 
Sizing/Selection screen. 
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 Char. (Control) – Valve trim characteristic along with type of control 
displayed based on selections from Sizing/Selection screen. 

 Flow Direction – Direction of flow thru the valve displayed based on 
product selection from the Sizing/Selection screen. 
 

 Actuator – Parameters 
 

 Max. Allowable Air Press – Maximum limit of air supply pressure to the 
actuator. 

 Min. Required Air Press – Minimum amount of air supply pressure required 
for the actuator to achieve full valve travel. 

 Initial Bench Set – Initial pressure to the actuator to initiate travel without 
any pressure in the valve. 

 Final Bench Set – Final pressure to the actuator to achieve full valve travel 
without any pressure in the valve. 
 

 Actuator – Requirements 
 

 Stem Thrust or Torque – Thrust or torque necessary to achieve full valve 
shut-off. 

 Travel – Distance or degrees required for the valve to fully change positions 
(i.e. move from fully closed to fully open and vice-versa). 

 Shut Off OP – Differential pressure across the valve for full shut-off 
displayed based on user input from the Sizing/Selection screen. 
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Accessories 

 

The CIRCOR Select Accessories screen provides optional auxiliary components to be 
specified for the selected line item. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Accessories from the Sizing/Selection menu options to access the accessories 
screen. 
 

 Select manufacturer and model for accessories required to enable subsequent 
attributes, if any, in order to fully specify accessories chosen.  Default for all 
accessories is ‘None’ except as noted.  
 

 Important: Tubing/Fittings must be specified when choosing accessories, 
except for limit switch selections (unless complemented with other 
accessories). 
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 Note: A Data Plate is standard on all Leslie and Mallard products.  ‘Brass’ is 
default.  ‘Stainless Steel’ is available only if stainless steel tubing and fitting 
material is selected. 
 

 Pressure Controller is available for Mallard products only. 
 

 Exceptions, deviations, or special instructions regarding selected accessories can 
be noted in Item Notes (see Item Information section in this chapter). 
 

 Required accessories not available on this screen can be specified in user defined 
factory notes (see Factory Notes/QA Plan section in this chapter). 
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Materials 

 

The CIRCOR Select Materials screen displays the materials of construction for the 
selected line item.  In some cases, alternative materials may be specified. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Materials from the Sizing/Selection menu options to access the materials 
screen. 
 

 Materials are populated based on product selection from the Sizing/Selection 
screen.  Components not applicable to the product specified remain disabled. 
 

 If ‘Other’ is chosen for product material selections on the Sizing/Selection screen, 
the material entered by the user will also appear here, where individual 
component material specifications can be edited. 
 

 Exceptions, deviations, or special instructions regarding selected materials can be 
noted in Item Notes (see Item Information section in this chapter). 
 

 Alternate materials not available on this screen can be specified in user defined 
factory notes (see Factory Notes/QA Plan section in this chapter). 
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Factory Notes/QA Plan 

 

The CIRCOR Select Factory Notes/QA Plan screen facilitates the attachment of 
factory notes and/or quality assurance requirements to the selected line item.  In 
addition to the many factory notes available, user defined factory notes can be 
generated, edited, and attached to the selected line item. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Factory Notes/QA Plan from the Sizing/Selection menu options to access the 
Factory Notes/QA Plan screen. 
 

 Available Factory Notes are contained in the panel on the left.  Selected Factory 
Notes attached to the line item are contained in the panel on the right. 
 

 To add a factory note from Available Factory Notes to Selected Factory 
Notes, click on the Available Factory Note then click the “>” button. 
 

 To add all factory notes from Available Factory Notes to Selected Factory 
Notes, click on the “>>” button. 
 

 To remove a factory note from Selected Factory Notes to Available Factory 
Notes, click on the Selected Factory Note then click the “<” button. 
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 To remove all factory notes from Selected Factory Notes to Available 
Factory Notes, click on the “<<” button. 
 

 Note: Hydro Test, Seat Leak Test, and Functional Test are standard factory 
notes that cannot be removed from Selected Factory Notes. 
 

 Factory Note Description - Detailed description of the highlighted factory note.  
Click on any factory note within either panel to view its description. 
 

 Remarks for Selected Factory Note - Enter exceptions, deviations, or special 
instructions to the Selected Factory Note in this box.  Remarks can only be added 
to factory notes attached to the line item (i.e. within Selected Factory Notes).  
 

 Add/Edit User Defined Factory Note(s) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on the Add/Edit User Defined Factory Note(s) button to access the 
user defined factory note dialog box. 
 

 Click Add to generate a user defined factory note, and then enter the Title 
and Note Description.  Select the Assigned Category then click Save to 
incorporate the user defined factory note into the Available Factory Notes.  
Other options such as Edit, Delete, and Cancel are available in user defined 
factory dialog box.  Once completed, click Close to exit the dialog box. 
 

 Important: Attach the newly created User Defined Factory Note to the line 
item by adding it into Selected Factory Notes; click on the User Defined 
Factory Note in the Available Factory Note panel then click the “>” button. 
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Reports 

 

CIRCOR Select provides the following professional output reports: 
 

 Specification Sheet 
 Analysis Sheet 
 Factory Notes/QA Plan 
 Outline Drawing 
 Flow Curve 

 
The Reports menu contains the following menu options: Print Reports, Drawing, and 
Flow Curve. 
 
 
 
 
 
 
 

 Click on the down arrow “▼” next to Reports from the Sizing/Selection menu 
options to access the Reports menu options. 
 

 Reports - Print Reports 
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 Clicking Print Reports from the Reports menu options opens a dialog box to 
generate the desired output reports. 
 

 Print Options (check boxes) – Checking the box prints out the data as 
indicated (see Preferences in Chapter 10 Settings for more information).  
Checking/Un-checking ‘Select All’ selects/deselects all options, which can 
then be selected/de-selected individually. 
 

 Reports (check boxes) – Checking the box prints out the selected report.  
Checking/Un-checking ‘Select All’ selects/deselects all Report options, 
which can then be selected/de-selected individually.  Each report provides 
the following data: 
 

• Specification Sheet – Service condition data, calculated results, and 
valve selection details along with the actuator and selected accessories 
presented in the ISA format. 

• Analysis Sheet – Service conditions, velocities, flow conditions, and 
advisories (if selected). 

• Factory Notes/QA Plan – Valve ordering code, listing of all tag numbers, 
accessories, selected factory notes are presented as line items.  Project 
and item notes, if any, are included in this report. 

• Outline Drawing – Outline drawing with overall dimensions of the 
selected valve and actuator (if any). 

• Flow Curve – Graph and table of characteristic flow curve as a function 
of Cv versus travel. 
 

 Line Items (check boxes) – Checking the box prints out the selected line 
item.  Checking/Un-checking ‘Select All’ selects/deselects all options, 
which can then be selected/de-selected individually. 
 

 Generate PDF – Once all printing selections are made, clicking ‘Generate 
PDF’ will prompt you to save the output report file.  Upon saving, the PDF 
file displays the report.  For hardcopies, print the PDF file to a printer. 
 

 Close – Exits the Print Reports dialog box, returning to the main application. 
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 Reports – Drawing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Clicking Drawing from the Reports menu options displays a drawing of the 
selected line item on screen once a valve model has been selected. 
 

 ‘Zoom In’ and ‘Zoom Out’ icon buttons are provided for the drawing view. 
 

 To navigate away from the on screen drawing, select a menu item or menu 
item option. 
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 Reports – Flow Curve 
 

 
 
 

 Clicking Flow Curve from the Reports menu options opens a dialog box and 
displays a graph and table on screen of the characteristic flow curve as a 
function of Cv versus travel of the selected line item once a valve model has 
been selected. 
 

 To exit the flow curve dialog box, click the ‘X’, or close button, at the top 
right corner of the window. 
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Status Indicator (Config Status) 

 

The status indicator in CIRCOR Select reflects the current state of the selections 
made for the given line item.  The status indicator displays Valid, Factory Review 
Required, or Invalid.  The icon associated with each status is also reflected in the 
project navigation pane for each line item and for each of the Sizing/Selection menu 
item options.   
 
 

 
 

 Valid – Indicates that the all selections made for the line item or Sizing/Selection 
menu option are valid and complete. 

 
 

 
 

 Factory Review Required – Indicates that one or more selections require review 
by the factory to confirm that they are technically viable or within the scope of 
supply.  This status also calls attention to data manually input by the user. 

 
 

 
 

 Invalid – Indicates that one or more selections are in error or incomplete.  User is 
prompted to rectify errors and provide all required information.  Line items with a 
status of ‘Invalid’ should be corrected prior to submission to the factory. 

 

 
 

 Calculation and Saving Required – This status is applicable only on Alternate 
Solutions. On change of service conditions for Primary line item, the selections on 
Alternate solutions are required to be revalidated against updated service 
conditions. 
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9. Utilities 
 
 

In CIRCOR Select, Utilities provide the ability to import or export line items from a 
project using .xml file types.  It also contains a function to search line item data.  The 
Utilities menu contains the following menu options: Import, Export, and Search Tag, 
which are explained in detail below. 
 

Import 

 

To import one or more line items into the current project in CIRCOR Select: 
 

 
 

 Click Import from the Utilities menu to access the Import file dialog box. 
 

 Click on the folder icon to access the Open file dialog box, navigate and 
select an .xml file, and then click Open.  The details and line items of the 
selected file are displayed. 
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 All line items will be checked by default; check/un-check individual line 
items to select/de-select. 
 

 Enter New Description for each line item to be imported. 
 

 Click Import to import the selected line items into the current project. 
 

 Click Close to exit the Import dialog box and return to the main program. 
 

 Note: Only .xml files can be imported into a project; .xml files are created by 
exporting from a project. 

 
 

Export 

 

To export one or more line items from the current project in CIRCOR Select: 
 

 
 

 Click Export from the Utilities menu to access the Export file dialog box. 
 

 All line items will be checked by default; check/un-check individual line 
items to select/de-select. 
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 Click on the folder icon to access the Save As file dialog box, enter a 
location and file name, and then click Save. 
 

 Click Export to export the selected line items and save the .xml file in the 
location specified. 
 

 Click Close to exit the Export dialog box and return to the main program. 
 
 

Search Tag 

 

To search for line items based on tag numbers within a project in CIRCOR Select: 
 

 
 

 Click Search Tag from the Utilities menu to access the Search Tag dialog 
box. 
 

 Enter full or partial tag number, select the matching Condition, and then 
click Search to display a list of all the line items meeting the search 
criteria. 
 

 The following matching Condition can be selected: 
 

• Equals - Tag number that is exact match with the tag number entered. 

• Begins with – Tag number that begins with partial tag number entered. 
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• Contains – Tag number that contains partial tag number entered. 

• Ends with – Tag number that ends with partial tag number entered. 
 

 Double-click on a line item displayed from the search to navigate to the line 
item. 
 

 Click Close to exit the Search Tag dialog box and return to the main 
program. 
 

 Note:  Full tag number must be exactly entered for match condition ‘Equals’ 
otherwise it will not display any line items.  For the other three match 
conditions, partial tag numbers can be entered for search results. 
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10. Settings 
 
 

Settings contain the application defaults used while working in CIRCOR Select.  The 
Settings menu contains the Preferences menu option. 
 

Preferences 

 
 Click Preferences from the Settings menu to access the Preferences screen. 
 

 See Chapter 4 Application Startup, User Defaults section for detailed information 
on all the preferences. 
 

 Changes to preferences will apply to line items added subsequently.  Existing line 
items would not be affected. 
 

 Note:  For multiple profiles, the last selected profile is taken as the default 
profile for the next time the program is started.  To use an alternate profile 
upon starting a new project, delete the existing line item, change the profile, 
and then add a line item to use the selected profile preferences. 
 

 To navigate away from the Preferences screen, select a menu item or menu item 
option. 
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11. Help 
 
 

CIRCOR Select is equipped with Help to assist the user while working in the 
application and also provides information on the application itself.  The Help menu 
contains the Help Contents and About CIRCOR Select menu options. 

Help Contents 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click Help Contents from the Help menu to access the Help dialog box. 
 

 The dialog box acts in the same fashion as standard help for Windows applications. 
 

 To exit the Help dialog box, click the ‘X’, or close button, at the top right corner 
of the window. 

 

About CIRCOR Select 

 
 Click About CIRCOR Select from the Help menu to access the About CIRCOR Select 
dialog box. 
 

 The dialog box provides the following pertinent information: 
 

 Version - Current version of the application. 
 

 Date - Release date of the current version. 
 

 Copyright information 
 

 Click Ok to exit the About CIRCOR Select dialog box and return to the application. 
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12. Technical Support 
 
 
For technical assistance, please send an email to: 
 

support@circorselect.com 
 
For a list of current issues and frequently asked questions, see the Known Issues and 
FAQ documents online at: 
 
 http://www.CircorSelect.com  
 
Please use the following format to report any problems, errors, or issues with the  
eprogram. 
 
User Name  : Your name 
 
Company Name : Your Company name 
 
Application  : CIRCOR Select 
 
Version  : Current Program version 
 
Operating System : Type and version of MS Windows® 
 
Error Description : Provide the following information: 
 

 Basic description of error 
 

 Occurrence – On specific event and steps to reproduce the event 
 

 Data, in all cases 
 

 Screen shot(s) 
 
 


